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Chapter 1

Introduction

IASEL is a simple program for computing the area occupied by components in
an image. It was written for obtaining the area occupied by types of cells in a
Bee Hive frame for Hort Research in December 2008 and January 2009.

1.1 Area Computation

Area is computed in units of one pixel. The user selects pixels in the image
(using the draw and fill tools) and the program counts them.

Knowing how many pixels something in the image occupies is not very useful
however. The real world area (square centimeters, cm2) that a pixel occupies
will vary between images depending on resolution and the distance between the
object and the camera.

So the size of a pixel in square centimeters needs to be determined in order
to obtain useful results. This is achieved using Area Profiles.

1.2 Area Profiles

An Area Profile defines the area of a reference object in an image. It includes a
width, a height, a name (for the user interface) and a short name (for inclusion
with the results). The dimensions in the Area Profile are linked to the image
by calibrating the software with the reference object.

For example, the reference object may be a Bee Hive frame. An Area Profile
for the hive frame is created (using instructions in Appendix B) that specifies
the height and width of a hive frame.

When processing an image, the user calibrates the calculations by creating
a box around the hive frame. Because the dimensions of the hive frame are
already known (they are stored in the Area Profile) we now know how many
pixels is in a centimeter. The vertical line of the box was drawn by the user as
x pixels long and the Area Profile tells the program that the height of the box
should be y centimeters.

This allows the software to convert between pixels and centimeters.

7
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1.3 Calculating Results

Once an Area Profile has been selected and the calibration box has been drawn
the software knows the size of a pixel. This allows the software to simply count
how many pixels the user has selected (coloured in) to compute the size.

The results are then provided as the number of pixels in the calibration box,
the number of pixels selected, the percentage of pixels selected in the calibration
box and the computed area in square centimeters. More information on handling
results can be found in Chapter 5.

1.4 System Requirements

IASEL is a Java program. It is designed with portability in mind and is tested
on both Windows and Linux. In theory it should also run on MacOS X and
other UNIX systems.

The software is primarily tested with Sun Java 1.6 (Java 6). It has not been
tested on older versions or any 3rd-party Java Virtual Machines.

As a result, IASEL requires at least a computer that meets the minimum
system requirements of Sun Java 6. These are available in Table 1.1.

CPU Operating System RAM Disk Space

Intel 32-bit

Windows XP Professional (SP1) 64mb 98MB
Windows XP Home 64mb 98MB
Windows 2000 Professional (SP3+) 64mb 98MB
Windows Server 2003, Web Edition 128mb 98MB
Windows Server 2003, Std Edition 128mb 98MB
Windows Vista 128mb 98MB
Linux 64mb 58MB
Solaris 8 64mb 53MB
Solaris 9 64mb 53MB
Solaris 10 64mb 53MB

Intel 64bit

Windows XP 128mb 110MB
Windows Server 2003 128mb 110MB
Windows Vista 128mb 110MB
Linux 64mb 58MB
Solaris 10 64mb 53MB

SPARC 32-bit
Solaris 8 64mb 65MB
Solaris 9 64mb 65MB
Solaris 10 64mb 65MB

SPARC 32-bit
Solaris 8 64mb 53MB
Solaris 9 64mb 53MB
Solaris 10 64mb 53MB

Table 1.1: Java 1.6 System Requirements

In addition, it is recommended that your computer meets the system re-
quirements in Table 1.2.
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Operating System Windows or Linux

CPU 2GHz Intel Pentium 4 or better
1.8GHz AMD Processor or better

RAM 256MB
Disk Space 1MB of disk space

Table 1.2: IASEL System Requirements

1.5 License

IASEL is Free Software (Open Source) licensed under the GNU General Public
License (GPL). A brief license statement may be found below. For full details,
see the GPL license text which you should have received with your copy of
IASEL.

IASEL (C) Copyright David Goodwin, 2008, 2009.

IASEL is free software; you can redistribute it and/or modify
it under the terms of the GNU General Public License as published
by the Free Software Foundation; either version 2 of the License,
or (at your option) any later version.

IASEL software is distributed in the hope that it will be useful,
but WITHOUT ANY WARRANTY; without even the implied warranty of
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the
GNU General Public License for more details.

You should have received a copy of the GNU General Public License
along with IASEL software; if not, write to:
Free Software Foundation, Inc.
51 Franklin St
Fifth Floor
Boston, MA 02110-1301 USA
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Chapter 2

User Interface

The user interface consists of a number of windows:

1. Main Window

2. Work Queue

3. Results Window

4. Export Results window

The Work Queue is discussed in section 3.2. The Results Window and the
Export Results Window are handled in chapter 5. The Main Window is covered
below.

2.1 Main Window

The Main Window is where the image processing is done. It shows you the
image you are currently working on along with any area you have selected and
the boundary box you have specified for the reference object. Its title bar shows
the name of the file you are currently working on along with its position in the
Work Queue (Described in section 3.2) if it was obtained from there.

The Main Window consists of three main sections (outlined and numbered
in figure 2.1):

1. Menu Bar

2. Tool Bar

3. Display Area

The Display Area is where the current image is shown and where the selection
is drawn. The tool bar provides quick access to some options available from the
menus.

11
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Figure 2.1: Main Window Sections



Chapter 3

Opening Images

There are two ways of opening images in the software. The first and most simple
way is to directly open the image from the file menu. This is not convenient
when there is a large set of images to process. For this purpose, the Work Queue
is provided.

3.1 Opening an individual image

To open an individual image choose the Open Image option from the File menu
(Figure 3.1). This will bring up a standard open file dialog for you to select the
image to open. When you have chosen the image, it will immediately appear in
the display area of the program.

Figure 3.1: The File Menu

3.2 The Work Queue

The Work Queue allows you to create a list of images that need to be processed
and then process them one after another with a single click. This allows multiple
images to be processed much faster than opening each image one at a time. You
can add an entire directory of images to the queue at once or you can add images
individually.

The Work Queue window can be accessed from the View Menu of the Main
Window as shown in figure 3.3.

13
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Figure 3.2: The Work Queue

Figure 3.3: Accessing the Work Queue from the Main Windows View menu

3.2.1 Adding a single image to the Queue

A single image can be added to the work queue by either using the “Add File”
button in the work queue window (see Figure 3.2) or the “Add File to Queue”
item in the “File” menu of the main window (see Figure 3.1). Using either
option will bring up a normal file open dialog where you can choose the file
to add to the queue. When you select OK on the file open dialog the selected
image file will be added to the end of the queue.

3.2.2 Adding multiple images to the Queue

Adding multiple images to the end of the queue is similar to adding a single
image. You can use either the “Add Directory” tool bar button on the work
queue window or the “Add Directory to Queue” item on the File Menu in the
main window. When selecting either option, a standard open dialog will appear
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where you can select a directory to add to the queue.
Only directories will be visible in the dialog and you will have to press the

OK button on the dialog to accept (double-clicking on a directory will not accept
the dialog like double-clicking on a file will).

Once the dialog has been accepted, all image files directly in the directory
will be added to the end of the queue.

Note that this is not a recursive operation. Only images in the selected
directory will be added to the queue - images in any subdirectories will not be
included.

3.2.3 Clearing the Work Queue

To clear the Work Queue, click on the Clear Queue toolbar button. This will
ask for confirmation before clearing all entries from the work queue. Once the
queue has been cleared there is no way to restore the former content except to
add it all again.

3.2.4 Using the Work Queue

Once a number of images have been added to the queue you can process them
one at a time in order using the “Next Image” button on the main window
toolbar. If no images have been loaded in the program yet, you will have to
push this button to load the first image from the queue.

This button performs the same action as the “Accept Solution” button (de-
scribed in Section 5.1), marks the current image as completed (A tick will be
placed next to it) in the work queue window (if the current image came from
the work queue) and then opens the next image in the queue.

When there is nothing left in the queue or the end of the queue has been
reached, the button will no longer move onto the next image and the display
area will go blank.

Figure 3.4: The Next Image toolbar button
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Chapter 4

Performing Selections

Once an image has been loaded into the program, the following must be done
before any results can be obtained:

1. Define the bounding box for the reference object in the image (Calibration)

2. Select any desired area

(a) Draw around areas to be selected

(b) Fill in areas

4.1 View Controls

Zoom and Pan are provided to help manage large images. Pan is controlled only
with the mouse, Zoom can be controlled both from the menu (Figure 4.1) and
with the mouse. An option to show or hide the selection is also available under
the view menu.

4.1.1 Zoom

The zoom feature is primarily controlled with the mouse wheel. To zoom out,
turn the wheel as if scrolling down a page. You can also zoom out by choosing
the Decrease Zoom menu item (Or press D, the menu items shortcut key)

To zoom in, position the mouse over the area you wish to zoom in on. Then
turn the mouse wheel in the opposite direction (as if scrolling up a page) to
zoom in. You can also zoom in on the center of the image by choosing Increase
Zoom (shortcut key S) from the Zoom menu.

Other Zoom Controls

From the Zoom submenu of the View menu (See Figure 4.1) you can reset the
zoom level of the image. Two reset options are provided - Zoom to Fit and
Zoom to Actual Size.

The Zoom to Fit option tries to make the image fit in the display area. If
the image is too big it will zoom out until all of the image is visible. If the
image is smaller than the display area it will zoom in on the image until it fills
as much of the display area as possible without hiding any portion of the image.

17
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Figure 4.1: The Zoom Menu

The Zoom to Actual Size option resets the Zoom to 100% showing the image
at its actual size regardless of if all of it is visible or not.

4.1.2 Pan

The image can be moved around on screen by holding down the right mouse
button and dragging in the desired direction.

4.1.3 Show Selection

The selection drawn can be shown or hidden using the Show Selection menu
item (Figure 4.2) which has the shortcut key X. Turning off this option does
not clear the selection - it only stops the program from drawing it. When turned
back on again the selection will reappear. This can be useful when area under
the selection needs to be viewed - pressing X (or using the menu item) will
hide the selection showing everything under it. Pressing it again will make the
selection reappear.

Figure 4.2: Show Selection menu item
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4.2 Calibration

The first thing that should be done when processing an image is to select the
item (otherwise known as the reference object) in which area is being measured
(more details in Section 1.2). This is done using the Calibrate button (Figure
4.3).

Figure 4.3: The Calibrate toolbar button

First a prompt will appear saying to click in the Top left. At this point you
should click on the top left corner of the item (Figure 4.4).

Figure 4.4: Calibrate first stage

Next a prompt will appear saying to click in the Bottom right. At this point
you should click on the bottom right corner of the item (Figure 4.5).

This will cause a blue box to appear which should follow the border of the
item in which the area is being measured if the picture is taken straight on
(Figure 4.6).

When this appears, initial setup for the image is complete and the Draw
Selection tool is automatically activated.
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Figure 4.5: Calibrate second stage

4.3 Drawing the Selection

To begin drawing the selection, click on the draw selection button on the toolbar
(Figure 4.7) if the tool is not already active (it is automatically selected after
calibration).

The selected parts of the image are coloured over in red. Any pixels that
have been coloured red will be counted towards the area which will be calculated
later.

The draw selection tool can be used to colour parts of the image red for
inclusion in the area. This can be done either by zooming in and filling in the
area with the draw tool, or by drawing an outline around the area and using
the fill tool.

The first option is not useful when large areas want to be selected - colouring
half the image with the draw selection tool would take a great deal of time. For
this purpose, the fill selection tool is provided.

4.4 Filling selection areas

To use the fill selection tool, first draw a closed loop around the part of the
image to be coloured. There must not be any gaps in the loop, otherwise the
entire image will be coloured when the fill selection tool is used.
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Figure 4.6: Calibrate complete

Figure 4.7: The Draw Selection toolbar button

4.4.1 Joining selection ends

To make drawing the closed loop faster and easier, a method of immediately
closing the loop is provided. This will draw a straight line from the start of the
loop to where the mouse pointer.

The feature is activated by pressing the right mouse button at any time
while drawing a line. When the left mouse button is released, the two ends of
the line will be joined.

This means that the loop must be drawn as one line (you cant take your
finger off the mouse button). To colour a square object (Figure 4.8) in the image
red, you would click in the top left corner of the image, drag down to the bottom
left corner, drag along the bottom, up the right side to the top right corner.
Then you would press and release the right mouse button before releasing the
left mouse button. When the left mouse button is released, a line will be drawn
from the start of the line to where the mouse is - this would be along the top
of the square object (Figure 4.8).
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Figure 4.8: Drawing a Selection around an Object

4.4.2 Filling Selections

To fill a selection (colour all of the area within the selection red), first click on
the Fill Selection button (Figure 4.9) and then click inside the selected area. If
there are no gaps in the line around the desired area, the area will be coloured
red. If there are any gaps, the entire image will be coloured red and you will
have to start again (there is not yet any undo feature) by pressing the Clear
Selection button on the toolbar..

Figure 4.9: The Fill Selection toolbar button



Chapter 5

Handling Results

When you have finished selecting the desired areas of the image you need to
need to accept the selection. How this is done depends on if you are using the
Work Queue (Section 3.2) as described in Using the Work Queue (3.2.4) or have
just loaded an individual image (Section 3.1).

If you have just loaded an individual image, press the Accept Selection but-
ton (Figure 5.1). If you are using the Work Queue, press the Next Image button
(Figure 3.4).

When one of these buttons is pressed there may be a slight delay as the soft-
ware computes the size of the selected area. The delay length should normally
be quite short unless the image is very large or the computer is very slow.

Figure 5.1: The Accept Selection toolbar button

If the Calibration step was forgotten a prompt (Figure 5.2) will appear asking
you if you wish to proceed. Without performing the calibration step the results
may come out incorrect. To go back and perform the calibration step just press
Cancel and then perform the calibration as described in Section 4.2.

If you wish to proceed without performing any calibration, just press OK
and the normal results gathering process will resume.

Figure 5.2: No Calibration Message

23
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5.1 Obtaining Results

Once the selection has been accepted a number of prompts will appear asking
for additional information to be included with the results. This additional
information includes:

1. A Tag

2. The Area Type

Once both pieces of information have been acquired the results for the cur-
rent image will be automatically added to the end of the results window and
the current image will be unloaded. If the Next Image button was used then
the next image in the Work Queue will then be loaded ready to be processed.

5.1.1 Tags

The first information requested upon completion of the selection is a tag. This
can be any text you wish to include with the results for this image. If you have
nothing to include just leave the box blank and click OK.

Clicking Cancel will cancel accepting the results and you will have to press
the Accept Selection or Next Image button again.

Figure 5.3: The Input Tag dialog box

5.1.2 Area Types

The next prompt to appear will ask you to select the area profile that best
fits the current image. This can be done by selecting an area profile from the
drop-down box (Figure 5.4) and then pressing OK. Like with the Input Tag
dialog, pressing Cancel here will require you to press Accept Selection or the
Next Image button again to get the results.

If there is only one Area Profile available, that one Area Profile will be used
automatically and you will not be asked to choose one.

If there is a problem with the file in which Area Profiles are stored, you will
see an error message like the one in Figure A.1. See Section A.1 for details on
how to fix this.
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Figure 5.4: The Area Profile Selection Box

5.2 Results Window

Once a selection has been accepted and any prompts for further information
have been answered, their results for the image will be appended to the list in
the Results Window.

To bring up the Results Window (Figure 5.6), click on Results Window in
the View menu (Figure 5.5). This will bring up the Results Window. To hide
the Results window, you can either click on the menu item again or just close
the window.

Figure 5.5: Show Results Window menu item

Results in the Results Window are organised into the columns described in
Table 5.1.

If the Selected Area and Area Type columns are blank there was likely a
problem with the file which defines Area Profiles. See section A.1 for more
details on this problem and how to fix it.

5.3 Exporting Results

Before exiting the software you must export all results from the results window
as these are not remembered between sessions. Exporting the results allows
you to easily import them into any common spreadsheet software to allow for
further processing.

It is recommended that you export your results occasionally as protection
against data loss - IASEL does not yet have any autosave feature.

5.3.1 CSV Files

CSV files are a basic data interchange format allowing software like OpenOf-
fice.org Calc and Microsoft Excel to import data from other sources. CSV files
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Field Description
Filename The name of the file this row is for
Tag The tag entered by the user when prompted
Frame Pixels The number of pixels within the calibration box
Selected Pixels The number of pixels coloured Red by the user in the

image. Note that selections are not cropped so any
pixels outside the calibration area will be counted
too.

Selected Percentage The percentage of Frame Pixels selected. If this is
greater than 100 then all frame pixels have been
selected as well as some outside the calibrated area.

Selected Area (cm2) The area in square-centimeters that has been se-
lected in the image. This relies on the selection
of the correct Area Profile as well as the calibra-
tion boxes dimensions being the same as the selected
Area Profile.

Area Type The short name of the selected Area Profile.

Table 5.1: Columns (fields) in Results Window

Figure 5.6: The Results Window

store their data as Comma-Separated Values such as in the example below:

"File Name", "Selected Area"
"/home/david/image.png", 3.14159
"/home/david/image2.png", 42

All common spreadsheet programs are capable of importing data from files
formatted like this which makes CSV the logical choice of data export file for-
mats for IASEL.
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5.3.2 Export Results Window

The Export Results Window allows you to export all of the results in the Results
Window to a CSV file. To bring up this window you can either select Export
Results to CSV File from the File menu in the Main Window (Figure 5.7) or
you can press the Export to CSV File button in the Results Window.

Figure 5.7: Export Results menu item

When either the menu item or the button is activated, the Export Results
Window (Figure 5.8) will appear. This window allows you to choose which fields
in the results you wish to export. This allows you to, for example, exclude the
Tag field if it is not used.

To select which fields you wish to have exported to the CSV file, hold down
the Ctrl key and click on each field in the list that you wish to appear in the
CSV file. Selected fields will appear blue in the list.

Figure 5.8: The Export Results Window

Once you have selected the desired fields, press the Export button. This will
bring up a File Save dialog where you can enter a filename to save the results as.
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This filename should end in .csv so that other software knows how to interact
with it properly.

If you decide you do not wish to export any results at this time just press
the Cancel button to dismiss the dialog.

Exported results are not cleared from the results window. If you wish to
clear the results window after exporting, see Section 5.4.

5.4 Clearing Results

If you are processing images in batches you may wish to export the results for
each batch into its own CSV file. In order to do this a way of clearing the
Results Window between batches is required.

All results in the Results Window can be cleared by pressing the Clear
Results button. This will cause a prompt to appear asking if you really wish to
proceed - once the results are cleared they can not be restored. Make sure you
have already exported the results if they are important before clicking on OK.

There is not currently any way of removing individual results - this may be
provided in a future version if required. For now if a mistake is made on an
image just process that image again. You can remove any bad entries when you
import the CSV file into a spreadsheet program.



Appendix A

Troubleshooting

A number of things can go wrong during normal operation of the program or
during the initial setup. This appendix provides an overview of what to do in
the event of something going wrong.

A.1 Unable to open Area Profile information
file

A.1.1 Problem

A message with the text “Unable to open Area Profile information file. Area
computations will be disabled for this session” (Figure A.1) appears after you
have entered a tag when accepting the selection for an image.

A.1.2 Impact

This message will only appear once during the session. As it states, area compu-
tations will be disabled until the problem is fixed and the program is restarted.
The Selected Area and Area Type columns in the results will be left blank.

If only the number of selected pixels, total pixels and selected percentage are
required (the computed area in cm2 is not important) then this message can be
safely ignored.

A.1.3 Causes

The following are possible causes of this problem:

Figure A.1: Area Profile Information file not found
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Figure A.2: Windows Shortcut Properties Dialog

1. area_profiles.ini does not exist.

2. The software does not have permission to read area_profiles.ini.

3. area_profiles.ini could not be found because the working directory is
incorrect.

A.1.4 Solutions

1. Create the file as described in Appendix B.

2. Ask your System Administrator to provide you with read access to the file

3. Start the program from inside the directory where the area_profiles.ini
file lives (See below)

Changing the Working Directory on Windows

If the program is being started with a Shortcut, enter the full directory name
(e.g., C:\IASEL) in the Start in field of the shortcuts properties dialog (on the
Shortcut tab, Figure A.2).

If the program is being started by clicking on the .jar file, run Notepad and
enter the following text:

java -jar iasel.jar
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Figure A.3: KDE 3.5 Application Link Properties

and save it as run.bat in the same directory as area_profiles.ini. If iasel.jar
is in a different directory from area_profiles.ini you will have to include the
full directory name, for example:

java -jar C:\IASEL\iasel.jar

Likewise, if your .jar file has been renamed to something different you should
use that name instead of iasel.jar.

Changing the Working Directory on Linux (KDE 3.5)

In the properties dialog (A.3) for the Application Link, enter the directory where
area_profiles.ini lives in the Work path box. In this example, area_profiles.ini
is in the same directory as IASEL.

Changing the Working Directory on Other Systems

Changing the working on other Linux desktop environments should be fairly
similar to how it is done in KDE 3.5. If you encounter difficulties, consult your
desktop environments documentation.

While IASEL is probably compatible with other UNIX systems, MacOS X
and OpenVMS current versions are not tested with platforms other than Linux
and Windows. Any problems with other platforms are outside the scope of this
manual.

A.2 Unhandled Exception Errors

It is not possible to forsee all ways in which the software may be used or how its
components may interact. As such, unanticipated errors may occur which the
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software was not designed to be able to handle. In these cases, an Unhandled
Exception occurs.

An Unhandled Exception is an exception (error) that the software lacks any
code to handle. When one occurs, the software stops what ever it is doing to
prevent damage or further malfunction. An Unhandled Exception error message
is then displayed such as the one in Figure A.4.

Figure A.4: Unhandled Exception Message

The Unhandled Exception Message (Figure A.4) contains detailed informa-
tion on the error in the text area at the bottom of the window. These details
include what the error was, where in the program it was and what happend
directly before. This information is required in order to diagnose the fault and
fix it.

As an Unhandled Exception likely indicates a bug in the program, the excep-
tion details should be copied and attached to a bug report including a description
of how to reproduce the error if possible. See Section A.3 for more details on
reporting bugs.

A.3 Reporting Bugs

When a bug in the software is found (including if the program performs in an
unexpected way), a bug report should be made in order for it to be fixed quickly.
This report should include:

1. A description of the bug.

2. Your Operating System.

3. The Specifications of your computer.

4. The version of the software you are using.
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5. A copy of the Exception details if there was an unhandled exception.

6. A description of what you were doing leading up to the problem.

7. Instructions on reproducing the problem if possible.

The report should then be emailed to bugs@zx.net.nz. If possible the bug
will be fixed in the next version of the software. If no major or minor release is
due for release soon, a patch release will be made.

A.3.1 Example Bug Report

1. An Unhandled Exception occurs when trying to load the flood fill tool
before an image has been loaded.

2. Operating System: Windows XP Service Pack 3

3. HP-Compaq nx6125 Laptop, AMD Turion64 1.8GHz CPU, 512MB RAM

4. IASEL version 1.1

5. java.lang.NullPointerException
at iasel.ImageCalcPanel.getPoint(ImageCalcPanel.java:4)
at iasel.ImageCalcPanel.flood(ImageCalcPanel.java:459)
...

6. Program was opened, then the fill selection tool was used. No image was
opened.

7. Start Program, click on Flood Fill toolbar button, then click on the image
area.
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Appendix B

Defining Area Profiles

Calculating the selected Area (rather than the selected percentage) uses Area
Profiles which are defined in area_profiles.ini, a windows INI format file.

When no Area Profiles are present in the file, area calculations in the pro-
gram will be disabled. If only one Area Profile is present, that one will be
automatically used. If more than one Area Profile is present, the user will be
asked which profile to use for each image.

B.1 INI Format Files

INI files contain grouped key-value pairs. Group names are contained in square
brackets ([ and ]). Every key-value pair that comes after a group name belongs
to that group. The software expects certain group names to be present - when
creating area_profiles.ini you must use these group names.

Key-value pairs are written as key=value. Like with group names, the keys
that you can use are defined by the software. Each key has its own purpose and
expected value type.

B.2 Keys

B.2.1 information group

key type example value purpose
entries Integer 1 Defines how many Area Profiles are in

the file.

Key: entries

The entries key defines how many area profiles are present in the file. When
ever an area profile is added or removed, this key must be updated to reflect
the new number of area profiles present in the file. If there are no area profiles
present, this number should be 0. If there are 5 area profiles present, this
number should be 5.

If the value is set to be lower than the number of area profiles present in the
file, all area profiles after the set value will be ignored.

35
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B.2.2 numbered groups (1, 2, 3, etc)

key type example value purpose
display-name String Normal Area A descriptive name for the pro-

file that will be shown to the
user.

short-name String norm The name that will be inserted
into the results.

width Double 5.5 The width of the area in cm.
depth Double 10.9 The depth (or height) of the

area in cm.
These groups represent Area Profiles and each group name must be a num-

ber. There must not be any gaps in the numbering. This means that numbering
area profiles 1, 2, 5, 6 is not valid. Assigning two area profiles the same num-
ber is also not allowed - if this is done one of the area profiles will be ignored.
Numbers can be no higher than the value set for the entries key under the
information group. Any area profiles numbered higher than this value will be
ignored.

The ordering of area profiles in the file does not make any difference. Having
the sections arranged 1, 2, 3 or 3, 1, 2 is perfectly fine as long as there are no
gaps in the numbering.

Key: display-name

This is the name of the profile which is used in the programs user interface.
When more than one profile is available the user will be given a list of all the
display-names and asked which area profile to use.

This means that the display-name should be unique and descriptive to ensure
the user selects the correct profile when prompted.

The display-name will be presented to the user along with the dimensions
(e.g. “Normal Area (5.5 x 10.9)”)

Key: short-name

This is the name of the profile that is inserted into the results for each image that
the profile is used on. It should also be unique if this information is important.

Key: width

This is the width of the area in centimeters. Its type is Double Precision so it
can take values like 1215.912363477773.

Key: depth

This is the depth (or height) of the area in centimeters. Its type is Double
Precision so it can take values like 1215.912363477773.

B.3 Example File

The following example defines two Area Profiles, “Plastic Hive Frame” and
“Wood Hive Frame”
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[information]
entries=2

[1]
display-name=Plastic Hive Frame
short-name=plastic
width=43
depth=22

[2]
display-name=Wood Hive Frame
short-name=wood
width=42.5
depth=20.5
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Appendix C

Advanced Configuration

The IASEL configuration file, settings.ini, stores the default location for all
file dialogs such as those used when opening images or exporting results. The
file format is the same as that used by area_profiles.ini and is described in
Section B.1.

C.1 File Dialog Locations

The default locations are stored under the locations group which provides
three options:

1. update

2. img-open

3. export

C.1.1 update

If set to true the program will automatically update the img-open and export
settings when ever a file dialog is used. This allows the program to remember
the last directory used by an open image dialog or save results dialog.

If set to false all dialogs will default to the locations specified by the
img-open or export settings every time.

C.1.2 img-open and export

These store the default location for the file dialogs used by IASEL. What exactly
they do depends on their value and the value of the update setting.

The img-open setting is used for all file dialogs that allow the user to open
images (including those used for adding images to the work queue). The export
setting is used only by the export results save dialog.

If update is set to true then these settings are maintained by IASEL and
are used to store the most recent directory for each type of file dialog. This
has the effect of IASEL remembering where you last opened an image or saved
results to. Any changes made to these settings will be erased the next time a
file dialog is used.
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If update is set to false then these allow for a user-defined default directory
for each type of file dialog. Every time a file dialog is displayed it will automat-
ically go to the directory specified here. If no directory has been specified then
Java will decide what the default directory should be - this is usually the users
home directory.

C.2 Example File

The following example sets the two file dialogs, open image and export results,
to two different locations. This removes the need to browse for the directory
where images are stored or results are exported to every time.

[locations]
update=false
img-open=C:\images
export=C:\results



Index

Area Computation, 7
Area Profiles, 7

Defining, 35
area profiles.ini, 35

Example, 36
File Format, 35
number of entries, 35
Numbered Groups, 36

depth, 36
display-name, 36
short-name, 36
width, 36

Calibration, 19
Failure to perform, 23

Images, 13
Opening Individual, 13
Work Queue, 13

Adding multiple images, 14
Adding single image, 14
Clearing, 15
Using, 15

License, 9

Overview, 7

Results, 23
Calculation, 8
Clearing, 28
Exporting, 25

CSV Files, 25
Export Results Window, 27

Obtaining, 24
Specifying Area Types, 24
Tags, 24

Selection, 17
Drawing, 20
Filling, 20

Fill tool, 22

Joining Ends, 21
Hiding and Showing, 18

settings.ini, 39
Example, 40
File Dialog Locations, 39
File Format, 35
Groups

locations, 39
Keys

export, 39
img-open, 39
update, 39

System Requirements, 8

Troubleshooting, 29
Changing working directory

Linux (KDE 3.5), 31
Other Systems, 31
Windows, 30

Reporting Bugs, 32
Example Bug Report, 33

Unable to open area profiles, 29
Causes, 29
Impact, 29
Problem, 29
Solutions, 30

Unhandled Exceptions, 31

View Controls, 17
Pan, 18
Show Selection, 18
Zoom, 17

Decreasing, 17
Increasing, 17
to Actual Size, 17
to Fit, 17
Zoom Menu, 18

Windows
Export Results, 27
Main Window, 11

41



42 INDEX

Results, 25
Work Queue, 13


	Introduction
	Area Computation
	Area Profiles
	Calculating Results
	System Requirements
	License

	User Interface
	Main Window

	Opening Images
	Opening an individual image
	The Work Queue
	Adding a single image to the Queue
	Adding multiple images to the Queue
	Clearing the Work Queue
	Using the Work Queue


	Performing Selections
	View Controls
	Zoom
	Pan
	Show Selection

	Calibration
	Drawing the Selection
	Filling selection areas
	Joining selection ends
	Filling Selections


	Handling Results
	Obtaining Results
	Tags
	Area Types

	Results Window
	Exporting Results
	CSV Files
	Export Results Window

	Clearing Results

	Troubleshooting
	Unable to open Area Profile information file
	Problem
	Impact
	Causes
	Solutions

	Unhandled Exception Errors
	Reporting Bugs
	Example Bug Report


	Defining Area Profiles
	INI Format Files
	Keys
	information group
	numbered groups (1, 2, 3, etc)

	Example File

	Advanced Configuration
	File Dialog Locations
	update
	img-open and export

	Example File


